
Editing and Using Graphics:

My Calendar includes a simple PICT, TIFF and GIF bit map editor.    You can create and edit 
PICT files and edit TIFF and GIF files using simple menu commands and tools. You can then 
include your graphics on your calendars!

Minimum System Requirements:

MEMORY:MEMORY:MEMORY

Creating and editing bit map images requires a lot of memory.    The standard memory 
partition of 1800k will allow you to edit letter size bit maps with 256 colors and one level of 
undo.    If you do not plan to use the graphic editor you can lower the memory partition to 
1200k to 1400k.

If you create or edit larger images, open or create images with thousands or millions of 
colors you will need to increase the amount of memory available if you are using System 7.0
or later.    You can save memory by setting your system to 4 bit or 8 bit mode if you have the 
ability to display 16 or 256 colors. This will allow you to edit larger images with less memory.

My Calendar can edit black and white or color images. You can open and save images with 
thousands or millions of colors.

General:

My Calendar can create and edit PICT files. It can also open TIFF and GIF files. It is a bitmap 
editor which means it edits images pixel by pixel instead of by object like Mac Draw or CAD 
programs.

The size of image you can create is only limited by the amount of memory you have and can
allocate to the program.    If you are using a system prior to 7.0 the maximum available 
memory will be allocated to the program. If you are using a color Macintosh with System 7.0 
or later you will need approximately 1600 to 1800k to edit a letter size image in 8 bit color, 
proportionally larger for larger images or images that have thousands or millions of colors. If 
you are getting memory error notices when creating or editing images then you must quit 
and allocate more memory to the program.

NOTE: This is a bitmap editor. If you open images created with programs that create PICT 
objects (Such as Mac Draw or CAD type programs) and then save the changes, the image 
will be convertedvto a bitmap. Also if you save GIF or TIFF files without using Save As.. the 
file format will be changed to PICT.

My Calendar can open RGB and CMYK TIFF files but cannot open compressed files.    Opening
TIFF files (especially CMYK TIFF files) can take a while. A spinning cursor will let you know 
the file is being processed.

Windows:



More than one editing window can be open at one time. Each image window requires more 
memory. With enough memory you can have dozens of large images open at the same time.
You can copy and paste between any of the windows.

Each window layout is the same. In the bottom left corner of the window are the following 
tools and displays:

1.    The zoom tool - This consists of the small and large mountain tools that allow you to 
zoom in to 1600% of the actual size or out to 12% of the actual size.    You can edit images at
any magnification.    The number in between the tools represents the current magnification 
percentage.

2.    The image color depth display - Just to the right of the zoom tool is a rectangle that 
displays the bit depth of the current image. My Free Paint can edit anything from black and 
white images to images with millions of colors.

3.    The color selector - Just to the right is the color selector. Click on the rectangle and color 
selector will be displayed.    While holding down the mouse move the cursor over the color 
you wish to use. Release the mouse to select the color.    The color, pattern and line 
indicators will be updated with your selection.

4.    The pattern selector - Just to the right again is the pattern selector. Click this rectangle 
and a pattern selector will pop up for you to choose one of the available system patterns.    
This pattern will be used for all drawing tools.

5.    The line selector - To the right again is the line size selector. You can select the size of 
lines used with the line, rectangle and circle tools.    Sizes available are from 1 pixel to 8 
pixels in size.

In the upper right corner of the window are nine editing tools for operating the program:

1.    The Hand tool - You can use this tool to grab the image and move the viewing area to 
any location if the image is larger than the current window. It is also used to drag current 
selected areas.

2.    The Selection tool - This tool allows you to select a rectangular area of the current image
for copying. It can also be used to constrain a PICT image on the clipboard to a specific area 
when pasting into an image.

3.    The Pen tool - This tool is used to draw on the image. It draws in the currently selected 
color and pattern. If you click in a color that is already the selected color, the pen erases the 
pixel to white.

4.    The Eraser tool - Use this tool to erase areas on the image. You can also use the 
selection tool to select large areas of the image and then select Clear from the Edit menu.

5.    The Paint Brush tool - This tool paints on the image with an 8x8 brush in the currently 
selected color and pattern.

6.    The Paint Bucket tool - This tool is used to fill areas of the image with the currently 



selected color and pattern.

7.    The Line tool - This tool is used to draw lines in the currently selected pen size, pattern 
and color.

8.    The Rectangle tool - This tool is used to create rectangles in the currently selected pen 
size, pattern and color.

9.    The Oval tool - This tool is used to create ovals or circles in the currently selected pen 
size, pattern and color.

Menus:

Two basic menus are used in My Calendar to edit graphics:

1.    File Menu - This menu has commands that let you open, save, save as, close windows, 
create new images and print the image. New images are sized to match the current paper 
size you have selected in the Page Setup dialog.

2.    Edit Menu - You can use this menu to Cut, Copy, Paste, Clear, and Select All on the 
image. In addition the Undo command is available for most of the operations you can use on
the images.

Special Keys:

In addition to the above tools and menus, there are special keys that can replace some of 
the operations and modify others. They are:

1.    Option - This key selects the Hand tool while it is held down for scrolling the image.

2.    H - This key forces the hand tool mode. You do not need to hold the key down while it is 
used.

3.    S - This key selects the Selection tool.

4.    D - This key selects the Pencil tool.

5.    E - This key selects the Eraser tool.

6.    B - This key selects the Brush tool.

7.    F - This key selects the Paint Bucket tool.

8.    ` - This key acts as a single key Undo command.

9      - and + - These keys zoom in and out of the image.

The Option and Control keys modify the Cut and Copy commands in the following manner.



Option Cut/Copy: Copy the current selection in a transparent mode.

Control Cut/Copy: Copy the current selection in a PICT1 format. This format takes less 
memory but copies the image in black and white.

The Control, Shift and Command keys can also be used to modify drawing results in the 
following manner:

Hold down the Option key while saving a graphic to reduce the size of the graphic to the 
current window size.    This is handy to reduce the file size and therefore the memory 
required for editing or importing graphics.

Hold down the Control key while using the drawing tools to paint in transparent mode.    
Patterns will show thru the color and pattern of the drawing below.

Hold down the Shift key to constrain the Rectangle tool to drawing squares and the Oval tool
to drawing circles.

Hold down the Command key to fill the rectangles and ovals with the current color and 
pattern.

Hold down the Control key and drag a selection to drag a copy of the selected area.

Hold down the Control key while the Pencil tool is selected to change the tool to the eye 
dropper. This allows you to click on any pixel on the drawing to change the pen color to the 
pixel color selected.

 Adding graphics to calendars:

The first step in using a graphic is to import the graphic.    Select Load Graphic from the File 
menu and select the file you want to use.    My Calendar will import the graphic and create a 
preview window for you to confirm it is the graphic you wish to use.    You may close the 
window or leave it open and My Calendar will keep the graphic in memory.    Clicking on 
Close/Dispose closes the window and releases the graphic from memory.

Next you must create a space for the graphic on the calendar. Now you must open the 
Calendar Options window.    Click on the Calendar Options tool (the eleventh tool from the 
left) or use the Preferences command from the Edit menu. In the lower right corner of the 
window are four buttons below the label Graphics.    The check box must be checked to 
display the graphic on the calendar.    Now select to crop, center or scale the graphic.    
Cropping the graphic places the top left corner of the graphic in the top left corner of the 
graphic area and crops the right and bottom side of the graphic if it is larger than the 
available area.    Centering the graphic places the graphic in the center of the available area. 
If the graphic is larger than the available area it will be cropped.    The final option is Scale. 
This forces the graphic to fit in the available area.    Graphics larger than the available area 
are squeezed to fit and those that are smaller than the available area are stretched to fit.    
Click on the Apply button to make the choices temporary until you have completed the next 
step.



Click on the Calendar Size button on the Calendar Options window.    The Calendar Print Size 
window will be opened with a display that shows a representation of the current page size 
and the current calendar size.    You should see six edit fields that contain information on the 
maximum page size the current calendar size and the size devoted to the body of the 
calendar and the graphic.

You can enter sizes directly into the edit fields or you can use the two black handles that 
appear in the right hand corner of the dotted rectangle on the page display.    If you are just 
creating a new graphic space the graphic handle will appear at the top of the page display.    
Click on either the graphic sizing handle or the body sizing handle and drag the mouse to 
the desired size.    As you drag the mouse, the values in the appropriate edit fields will 
change value to reflect your actions.    When you are done you should see a page 
representation with two dotted rectangles showing the placement of the graphic (top 
rectangle) and the placement of the body of the calendar (bottom rectangle).    Click on the 
Done button to accept the final choices. My Calendar will check to see that the selections 
will fit within the current page size and notify you if there is a problem.

You will be returned to the Calendar Options window.    Now you must select to use the 
settings you created on a temporary basis, create a new setup file or make your choices the 
default choices.    If you want to use the settings on a temporary basis click on the Done 
button. To make your choices the default choices each time you open My Calendar click on 
the Default button.    To create a setup file you can use at any time click on the Save As.. 
button or use the Save Setup As.. command from the File menu.

You can now create a preview of your calendar or print your calendar with the graphic.    
Preview the calendar to confirm your settings. If you need to make changes, follow the steps
above. 

Only one graphic can be use at one time.    Use the Clear Graphic command under the File 
menu to remove the graphic from memory and free up the memory used for the graphic.    If 
you have allocated enough memory to My Calendar you should have no problems.    If you 
try to load large graphics and get a memory error message or erratic program behavior, 
allocate more memory to the application and try again.


